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 Flash 8I 
 
 Why use Flash? 
Simply said, you can use Flash to create your own animations, applications, games, and graphics with relative ease. 
Flash applications are great for the web, as they usually have small file sizes. 

Getting started 
To get started, simply double click the Macromedia Flash 8 icon on your desktop. Then grab some popcorn. 

Creating a new Flash document 
To create a new FLA document, click on “Flash document” in the Create New tab in the middle of the screen. 

 

Another way you can do it is to select “File” on the top selection panel, then click “New…”. 

Saving a document 
To save an FLA document, click on “File” in the top selection panel, then click “Save” or “Save as…”. Or, simple press 
the keys Ctrl+S. Your document will be saved in FLA format, with .fla extension. 

Creating SWF files 
In Macromedia Flash 8, the standalone application you create is called an .swf file. This .swf is basically the result of 
your work. Creating an .swf format of your FLA document is very simple. 

follow these steps to create one: 
1) Click on the “Control” button in the top selection panel 
2) Click on “Test Movie” in the menu that dropped down. Another way is to simply press Ctrl+Enter. A dialog box should 
popup, it displays how your actual Flash movie looks like. 

Now an .swf file is automatically generated in the folder where your FLA document is located. It is updated everytime 
you test your movie. 

The Flash 8 working environment 
This is the default layout of Flash 8. This is just an overview to make you familiar with the layout of Flash 8. 

The Stage 
The white box in the middle is the stage. Basically, you draw and animate stuff on the stage. The width and height of 
your Flash movie is determined by the stage size. 

By the way, objects on the gray area (called the pasteboard) won’t be visible in the movie, unless it is included within 
the stage. 
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The Colors tab 
You can use it to select or change the color of objects. 

The Color panel 
This is where you can edit the colors of objects. It is similar to the Colors tab, except that it contains more advanced 
settings. 

The Toolbar 
The tool bar contains all the tools you need to create and edit stuff on the stage. 

The View tab 
You can use it to zoom in or out, and move around the stage. 

The Options tab 
This tab shows settings for individual tools. It changes according to the tools you select. 

The Actions panel 
You use it to type in actionscript commands. This topic will be covered in more advanced tutorials. 

The Properties panel 
It is used to change the properties of objects, like frames, movieclips, lines, fills and more. It changes according to the 
object or tool selected. 

By the way, you can also change the color or size of the stage here. To change the size of the stage, you need to click 
the size (by default, 550×400 pixels) button, and then set the size in the dialog box that popped out. To change the 
color of the stage, simply select a background color, its icon is located on the right side of the size button. 

The Library 
It holds all objects (movieclips, tweens), or multimedia elements (bitmaps, audio, video) that was in the Flash document. 
Even if you delete the object, for instance, a video clip on the stage, a copy of it is still retained in the library. 

The Timeline 
It is used to create or edit animations. It contains frames, which plays an important role in making animations. 

 
Tools used to Draw and Create Graphics in Flash 8 

 
Introduction 
I’ll walk you through the tools used to draw stuff in Flash. 
These are the basic set of tools used to draw graphics in Macromedia Flash 8. Quick, grab some popcorn. 

Pencil Tool  

Line Tool  

Brush Tool 

Paint Bucket Tool 

Ink Bottle Tool 

Oval Tool  

Rectangle Tool/ Polystar Tool 
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First off, let’s see where is the area you can draw on in Flash 8. 

 

The place where you can draw on is the stage. It is the white area in the middle. You can also draw on the grey area, 
which is called the pasteboard, but only objects that are within the area of the stage can be seen in your finished Flash 
movie. 

Pencil Tool  
You can use the pencil tool to hand draw lines, just like a pencil. Select the tool by clicking on it’s icon on the Toolbar, 
then you can start drawing on the stage. Simple. Here is what you can draw using this tool. 

 

Line Tool  
You can use it to draw perfectly straight lines. But how do you use it? 

1) Click on the Line Tool icon. 
2) Then click on the stage, but don’t release your mouse yet. 
3) While holding your mouse, drag it across the stage, towards any direction. 
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4) Then release your mouse to create the line. 

 

Drag across the stage to form a line. 

Another tip here, you can create perfectly horizontal, vertical and diagonal lines by holding shift while dragging out a 
line. 

Brush Tool  
You use it to create thick “paints”. Use this tool to freely paint on the stage, similar to the pencil tool. 

Now that it’ function is clear, Here’s how you can customize it. 
You can increase the smoothness of the brush to create graphics that are sleeker, by 

1) clicking on the Brush Tool icon. 
2) then In the properties panel below, change the smoothness settings, by typing in a value between 0 to 100. 

 

One useful fact here, the color of the “paint” is determined by Fill color. It is not affected by changing Stroke color. 
Stroke color only affects lines. Anyway, here is a a graphic that I drawn using this tool. 

 

To learn more about using the Brush Tool, read this post. 

Paint Bucket Tool  
You  can use to fill colors into outlines of shapes. Before using this tool, you must first create an outline of a shape using 
the pencil tool or line tool. 

Now that it’s function is clear, let’s talk about a neat feature it has. The fact is that the Bucket Tool is able to fill in 
outlines that have small gaps. 
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Small gaps in outlines can be tolerated 

You can set the gap tolerance of the Bucket Tool by: 

1) clicking on Bucket Tool icon. 
2) then, click on the “Gap Size” icon, which is located below the Toolbar, in the ‘Options’ tab. 
3) then choose a criteria, I usually choose “close small gaps”. 
Thus, the Bucket tool is able to fill in outlines that have tiny gaps. 

By the way, another use of this tool is to change the fill color of existing graphics. 

 

An image I created using the Bucket Tool 

Ink Bottle Tool  
You can use this tool to add outlines to fills without outlines. You can also use it to change the color of existing outlines 
of a shape. 

So how do you use it? 
1) click on Ink Bottle Tool icon. 
2) then, click on a fill. 

And that’s it! Try it out yourself and see. 

Oval Tool  
You use this tool to create circles and ovals. But how do you use it? 

1) click on the Oval Tool icon. 
2) then click on the stage. 
3) while still holding your mouse, drag your mouse away from the point you clicked. A ghost outline of the oval should 
appear. Drag around until you get the shape and size you want, then release your mouse. 

One tip is to hold shift while dragging to create PERFECT circles. 

Rectangle Tool  
You can use this tool to create rectangles or squares. Simply use it as you would use the Oval Tool, the way of using it 
is similar. 

One tip is to hold shift while dragging to create perfect squares. 

Polystar Tool  
You can create perfect pentagons using this tool. Use it as you would use the 2 tools above. 
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The tricky part is to access this tool, you can’t find it anywhere on the Toolbar! 

Fear not. To access this tool, click and hold on the Rectangle Tool icon. After that, a box should drop down. Simply 
click on the Polystar Tool in the menu that dropped down, and the icon switches to Polystar Tool. And there you have it! 

If you want to change the icon back to Rectangle tool, do the same thing again. 

How to color in Macromedia Flash 8 
 
In this tutorial, I’ll show you how to color objects in Flash Professional 8. 

First off, there’s some facts that has to be cleared. There are basically 2 types of graphics in Flash, which 
are strokes and fills. 

In Flash, strokes simply means lines. It’s color is determined by ‘Stroke Color’. 

Fills are the ‘meat’, it’s color is determined by ‘Fill color’. Some common tools that create fills are the Brush and Bucket 
Tool. A fill’ 

You can change these colors at the Colors tab, which is located below the Toolbar. 

 

How do you change fill or stroke color? First, click on one of the color icons. Then select a color from the color swatches 
(see below). 

 

Using the Bucket Tool to color fills? 
You can also use the bucket tool to color fills, 

1) Click on Bucket Tool icon 

2) Choose a fill color, like green 
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3) Click on an existing fill. The figure below shows a red circle turning green. 

 

Using the Ink Bottle Tool to color outlines? 
You can also color of the outline of an object using Ink Bottle Tool. 

1) select Ink Bottle Tool icon 

2) then choose a stroke color,  like blue 

3) click on any part of the object. The figure below shows the black outline of the circle turned blue! 

 

Note: Technically, the Ink Bottle Tool doesn’t change the color of the circle’s outline, it actually replaces the outline with 
a new outline. 

What are Gradient Colors? 
So what are they? Basically, gradient colors are 2 or more colors transitioning together smoothly into one color. You can 
select gradient colors at the bottom of the fill or stroke color swatches. 

 

Gradient colors, at the bottom of the color swatches 
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Circles with gradient color 

  

And guess what, there are 2 types of gradident color. They are radial and linear color. Radial colors are radiated out in 
a circular way, while linear colors are spread across in a parallel way. 

An interesting fact is, you can change the direction of a radial color. 

 

Click on any part of the fill to change the radial color direction. 

You can also change the degree in which linear colors spread, and it’s direction. 

 

Click on the fill, then drag you mouse in any direction. Note that the spread and direction of the color is different. Also, 
the longer the distance you drag your mouse away from the point you clicked, the sparser the color spread. 

In Flash 8, you can even color strokes with gradient color! How can you do it? Simply select a stroke, then choose a 
gradient color in the Stroke Color swatches. 

You can even create your own gradient colors, as discussed in “How to create my own gradient colors in Flash 8?” 

How to create transparent graphics in Flash 8? 
You can create transparent or semi-transparent colors in Macromedia Flash 8 usingalpha colors. You can set the 
alpha value for both stroke and fill colors. Take a fill for example below. 

1) first, select a fill by clicking on it 

2) In the fill color swatches, click on the alpha down-arrow button 

3) Drag the alpha settings bar until it’s 50. Another way is to type in a number in the alpha text box 
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Drag alpha down to 50 

The fill should now be semi transparent. Now, objects in lower layers can show through the fill. 

 

The blue rectangle is in a lower layer. The rectangle can show through the red oval as it is semi transparent. 

You can basically do the same steps above for strokes. 

 
Basics of selecting and editing graphics in Macromedia Flash 8 

 
The tools that I’ll cover in this tutorial are: 

 
Selection Tool 

 
Lasso Tool 

 
Free Transform Tool 

 
Gradient Transform 

 
Eraser Tool 

How to use the Selection Tool?  
As the name suggest, the Selection Tool is mainly used to Select objects. So, how do you use it? 
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you select object(s) in an area, by choosing the selection tool, then drag a box to cover objects, then release your 

mouse. 

 
You can also select a whole object by double clicking on it's fill. 

 
You can select a stroke by clicking it once. 

 
You can also select a fill by clicking it just once. 

 
To move objects, choose the Selection tool, use it to select an object, then drag the object to another position. 

 

 
You can even bend strokes! Hover your mouse on a stroke, until your mouse looks like the cursor in the image above. 

Click down, don't release your mouse. Then, bend the stroke. 
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To change a stroke's angle, click on the edge of a stroke, but don't release your mouse. Drag your mouse to change the 

angle of the stroke. 

 
You can even bend fills by click-dragging the edge of a fill. 

How to use the Lasso Tool?  
You can use the Lasso Tool to select irregular shaped graphics with precision. Fact is, you use it like the pencil tool. 

 

1) click on Lasso Tool icon 

2) click down, hold your mouse, and you can start drawing out the selection line 

3) then release your mouse to select an object 

How to use the Free Transform Tool?  
You can use the free transform tool to rotate and change the size of objects. The word I’m going to substitute for 
‘changing the size of an object’ is ‘resize’. 

 

To rotate objects, hover your mouse at any of the 8 points around the object (after it is selected), until your mouse looks 
like the cursor in the image above. Click down, don’t release your mouse. Then, drag your mouse. The object’s rotation 

follows your mouse. 
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To resize objects, drag any of the 8 points around the object (after it is selected). 

The tiny white circly dot is the pivot point. You can drag the point to different locations so that the object selected would 
be rotated based on the point (refer to image above).Strangely, In Flash 8, this does not apply when resizing objects. 
You can only resize an object based on it’s pivot point when it is a movieclip or graphic object. This will be discussed in 
later tutorials. 

How to edit and change gradient colors? 
You can edit gradient colors using the Gradient Transform tool. Read this post know more about the tool. 

How to use the Eraser Tool?  

 

Simply click on the tool, then start erasing.You basically use it like the pencil tool or Brush tool. 

You can change the Eraser tool’s shape and size in Eraser Shape under Options (when Eraser tool is selected). 

 

Eraser Shape button, under Options 



 
 
 

SARVA EDUCATION (SITED) (Running- An I.T & Skill Advancement Training Programme)                                                                                                                                                             - 14 -                                                                                                                                         

                                                                       

 

Visit us at:  www.sarvaindia.com                                                                 Licensed by Govt. of India                                                                       ISO 9001:2015 Certified 

 

Eraser shape list 

 
How to animate frame by frame in Flash 8 

 
you’ll learn how to create frame by frame animation in Flash. This technique involves changing each keyframes of an 
animation to create movement. Here is a simple bouncing ball animation created frame by frame. 

This tutorial shows you how to create the animation above. 

1- Draw a ball 
Firstly, we’ll draw a ball using the Brush tool. 

 
 
Use the second smallest brush size the Brush tool has. 
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And make sure to set your view as 100%. 

 

2- Create a frame 
  

Press F7 to insert a blank keyframe into the timeline. This empties any graphics on the stage so that you can start 
drawing another piece of action. 

3- Use Onion Skin 
This enables you to view the previous animations you have drawn, which appears semi transparent.  Click on the icon 
to enable Onion Skin view. 

 
 
  
4- Draw the next action 
Make sure you selected the 2nd frame. If you did, draw the orb again, albeit with a slightly different action. 



 
 
 

SARVA EDUCATION (SITED) (Running- An I.T & Skill Advancement Training Programme)                                                                                                                                                             - 16 -                                                                                                                                         

                                                                       

 

Visit us at:  www.sarvaindia.com                                                                 Licensed by Govt. of India                                                                       ISO 9001:2015 Certified 

 
 
  
5- Draw and draw again until you complete the animation 
Repeat the procedure to complete the animation! Some tips here, if you can’t see previous animations using the Onion 
Skin view, make sure the Onion Skin box encompasses all frames. (Refer to figure below) 

  

 

6- Smoothen the graphics 

 

One more useful tip here, you can smoothen your graphics easily by selecting the orb you drawn, then click on the 
Smoothen icon (refer to figure above) several times. It is located in the Options tab. This feature eliminates shakiness 
from the graphics you drawn. It should look sleeker now  

 
How to use motion tween in Flash 8 

 
you’ll learn how to animate in Flash by applying motion tween, layers and other features in Macromedia Flash 8. Below 
is a simple animation made using motion tween. 

1- Create a new Layer 
  

Firstly, we’ll create a layer by clicking on the new layer icon. 
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2- Adding motion tween 

Motion tweening moves, rotates or resizes an objects in an animation. Here’s how you use motion tween. 

 

  

First, select layer 1, then draw a square using the Rectangle tool. Then, click on layer 2, and draw a circle using the 
Oval tool. 

  

 

You’ll notice that the occupied frames becomes grey. 

  

 

Then, right click on the frame in layer 2, and select “Create Motion Tween”. Do the same for layer 1. 

  

 

After that, click on the white or grey space where the 30th frame is located. Insert a keyframe by pressing F6. Another 
way is to right click on the timeline, and select “Insert Keyframe”. Do the same for both layers. An arrow should 
automatically appear between the beginning and end of the frames. This indicates that the motion tween is complete. 
But we’re not finished with it yet. 
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Notice the objects are automatically converted to a graphic symbol after the motion tween is created. Now, make sure 
the 30th frame is selected. then, drag the circle towards the left, and drag the square towards the right. 

3- Create fading effect 

 

Now let’s create the fading effect. We’ll click on the circle, then select “Alpha” from the Color menu in the properties 
panel, below the stage. 

  

 

Then, we’ll type in 0 as the alpha value, or drag the alpha settings bar in the menu button. Now, the circle should 
become invisible. Do the same procedure for the square. 
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Now it’s done! Test your movie by pressing Ctrl+Enter to view your animation. 

 
How to use Shape Tween in Flash 8 

 
Shape tween is an animation that involves transformation of one shape to another. You’ll learn how to create the flash 
animation below. 

Firstly, draw a circle using the Oval tool. 

 

Now we’ll try converting the frame to a shape tween. 

 

Let’s click on the 1st frame. Then, in the properties panel below the stage, we’ll select “Shape” in the “Tween” menu. 
Notice the frame becomes slightly greenish. 

 

Then, we’ll click on the 10th frame, and press F7 to insert an empty keyframe. 

Now you are supposed to draw the rectangle. But, you probably can’t place the rectangle in perfect alignment with the 
circle, because you can’t see it. A nice feature called “Onion Skin” in Flash can help you view frames before or after a 
selected frame. You can use Onion Skin to align your rectangle with the circle. 
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Make sure the last frame is selected. Then, click on the onion skin icon. You can’t see the circle’s “shadow” yet, this is 
because the onion skin did not affect the frame where the circle is placed in. 

 

 

So, we’ll drag the onion skin box located above the frames to encompass all frames. 

 

The circle’s semi transparent shadow should now show on the stage of the last frame. 

 

Now you can draw a rectangle on the stage, it should be positioned close to the circle. 

The shape tween is done! 

 
How to use motion guide in Flash 8 

 
Motion guide is a feature in Flash 8 that is similar to motion tween. The difference is that the object can be animated 
along a hand-drawn path. You’ll learn how to create the in Flash animation below using motion guide. 
 
First, we’ll draw a circle using the Oval tool. 
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And then, convert the frame containing the circle into a motion tween. Do so by right clicking on the frame and select 
“Create Motion Tween”. 

 

Now, we’ll select the 30th frame, and press F6 to add frames. 

 

Then, create a motion guide layer by clicking on the Add motion guide icon. (refer figure above) 

 

Then, we’ll draw a stroke inside the motion guide layer using the Pencil tool. Any stroke will do, no matter it’s shape, 
color or width. Most importantly , it must be a continuous stroke. 
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Note that the circle is fixed to the path of the stroke you drawn. So, make sure the circle in the first frame is at the start 
of the stroke. Then, move the circle in the last frame to the end of the stroke. 

And it’s done! 

 
How to create a button in Flash 8 

 
So how can you create a button in Flash? Truth be told, you can literally create one button under 10 seconds! This 
tutorial provides step-by-step instructions and tips on how to create one.  Grab some popcorn and sit tight. 

1- Draw an object 
Firstly, draw a square using the Rectangle tool. In case you don’t know how to draw one, read this tutorial which covers 
basics of drawing in Flash. 

 

2- Convert object to button 
Make sure your fully select the square, as it is made up of 2 parts, fill and strokes. Then, press F8. 

This dialog box will popup. 
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Click on the ‘Button’ radio button, then click ‘OK’. And now you have a button! 

Your square has been converted into a button symbol, which is indicated by the blue box around it when it is selected. 

3- Draw button graphics (Up/Over/Down) 
Let’s double click on the button you’ve just created. And you’ve just accessed it’s timeline. 

A button has 4 frames, ‘Up’, ‘Over’,'Down’,'Hit’. And let’s keep it that way. Trust me, we only need the 4 frames in a 
button. 

  

 

Now I’ll explain about these frames. When is the button is not touched by your mouse, it display’s the graphic in the ‘Up’ 
frame. And when the mouse is rolled over your button, it displays the ‘Over’ frame. When you click on the button, it 
displays the ‘Down’ frame, until you release your mouse, or move your mouse away from the button. 

So.. what about the ‘Hit’ frame? Graphic elements in the ‘Hit’ frame is never seen in your Flash movie. The ‘Hit’ frame’s 
only function is to define the area of the button that can be clicked. 

Back to instructions. Press F7 to add keyframes to the button’s timeline. Then, draw the button graphics into each 
frames. 
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And you’ll get a functional button. Click on the example below. 

 
Actionscript for buttons in Flash 

 
writing actionscripts for buttons in Flash. 

How to insert actionscript in buttons? 
First off, you’ll have to create a button. Draw a square, select it, then press F8, and select the ‘Button’ radio button, then 
click ‘Ok’. Read the previous flash button tutorialif you have trouble creating one. 

 

Phew, that was easy. Now, select the button. Look at the ‘actions’ panel below, click the panel to expand it. 

And here is the area where you can insert your actionscript. (Note that I prewritten some actionscript in it) 

 

on (Release){ 
play(); 
} 
Now I’ll try to break it down. Caution! Some terminology used. 

on (Release){ is an event handler that executes the actionscript when you releasedyour mouse, after your clicked the 
button. 

The curvy brace { signifies the opening of a event handler. 

Play() is a command that starts playing the timeline. Pretty self explanatory. 
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The curvy brace } closes the event. 

Button Events 
Here are more button events. 

on (press) – event is triggered when you click the button. 

on (release) – when you clicked the button, then released your mouse. 

on(releaseOutside) - when you clicked the button, move your mouse away from the button, and released your mouse. 

on(rollOver) – when your mouse touched the button once, without clicking it 

on(rollOut) – when you touched the button, then moved away your mouse. 

on(dragOver) – when you clicked on the button, while holding your click, move away from the button, then back to the 
button. 

on(dragOut) – when you click the button and pull your mouse away, while holding your click. 

Common & basic button actionscripts 
stop() – stops the timeline from playing. 

play() - starts playing the timeline. 

nextFrame() – goes to the next frame. 

prevFrame() – goes to the previous frame. 

gotoAndStop() – stops at the frame you specify. 

gotoAndPlay() – goes to and starts playing at the frame you specify. 

nextScene() – goes to the next scene. 

prevScene() – goes to the previous scene. 

 
How to make a button a link in Flash – getURL() 

 
This tutorial shows you how to make a button into a link in Flash using the getURL() actionscript command. If you want 
to know the basics of button creation in Flash, read these posts: how to create buttons in Flash, and actionscript for 
buttons in Flash. 

getURL(“my url”); 

Just replace “my url” with your website’s URL, and the button links to the site. 

Underneath is a sample actionscript of a working button link. 

on (press){ 
getURL("http://flashtutor.org/") 
} 
Here is the button containing the script above. Simply click it to open the specified URL. 

Applying getURL() parameters. 



 
 
 

SARVA EDUCATION (SITED) (Running- An I.T & Skill Advancement Training Programme)                                                                                                                                                             - 26 -                                                                                                                                         

                                                                       

 

Visit us at:  www.sarvaindia.com                                                                 Licensed by Govt. of India                                                                       ISO 9001:2015 Certified 

You can add parameters in the getURL() command so that it either opens a new window when clicked upon, or 
accesses the link in the current browser. 

getURL(“http://flashtutor.org/”, “_blank”) 
This command opens the link in a new window 

getURL(“http://flashtutor.org/”, “_self”) 
This command opens the link in the current tab or window. 

Send emails with getURL() function 
You can use the mailto: command to send emails to a specified URL. Try e-mailing me by clicking the button below, it’ll 
open up a new window. 

This is the actionscript in the button. 

on (release) { 
getURL("mailto:admin@flashtutor.org"); 
} 
Simply replace the email with your own email, and it’s done! 

 
Easing in Flash 8 

 
how to implement easing to your animations. If properly used, easing can make your animations look more professional 
and pleasing to the eye. 

Above is an animation with easing, it starts with a fast speed and decelerates smoothly. 

Here’s how you can apply easing to your animations. 

First thing you must know, easing can only be applied to tweens (includes motion/shape tween & motion guide). 

1- create a motion tween 
Firstly, create a motion tweened animation; if you don’t know how, you can visit the link. 

2- Apply easing 
Select the first frame of the motion tween, then look at the properties panel below. 

Notice the ‘Ease’ menu (refer to image below). 

 

You can set it from a range of -100 to 100. 

If you set the ease value to 100, the animation accelerates quickly, then slowly stops.  
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If you set the ease value to negative 100, the animation slowly starts, accelerates, and achieves it’s fastest speed at the 
end.  

You can even add easing to rotating motion tweened animation. 

Or, to shape tweens. 

Using Filters in Flash 8 
 
In Macromedia Flash 8, there is a handy feature called filters which can enhance graphics you drawn. 

The 5 type of filters that I frequently use are: Drop shadow, Blur, Glow, Bevel, and Adjust color.(excluding Gradient glow 
& Gradient Bevel) I wrote this tutorial in their order. 

  

 

  

The first thing you should know is that filters can only be applied to symbols, buttons and movieclips. Filters, 
surprisingly, can also be applied to text boxes. Filters cannot be applied to graphic symbols. 

 
Drop Shadow 
It generates a shadow for objects. To implement it, select ‘Shadow’ under the filter tab. 

Blur x & y defines how blurry the shadow is. 

Angle controls the direction of the shadow. 

Distance defines the distance of the shadow from the graphic. 

Strength defines the opacity of the shadow. 

What else you can create using shadow 
embossed text (created using a thin shadow, which is lighter than the background, with a 90 degree angle) 
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Blur 
‘Blur’ umm… blurs objects. To use it, select ‘Blur’ under the filter tab. 

Blur x & y controls the blurriness of the graphic. By default, the x & y blur values are locked, which means they are 
forced to be the same. To unlock it, press the tiny icon (refer to image below). 

You can then set the x & y blur value separately. (See images below) 

 

 
  

What else can you create using blur 
glowing strands of light 

 

fireballs 



 
 
 

SARVA EDUCATION (SITED) (Running- An I.T & Skill Advancement Training Programme)                                                                                                                                                             - 29 -                                                                                                                                         

                                                                       

 

Visit us at:  www.sarvaindia.com                                                                 Licensed by Govt. of India                                                                       ISO 9001:2015 Certified 

 

 
Glow 
It adds glow to an object. 

Blur x & y determines the blurriness of the glow 

Strength determines opacity of the glow 

Knockout will make the graphic invisible, while preserving the glow. Simply check the ‘knockout’ radio button to use it. 

Inner glow will make the glow shine inwards. 

What else you can create using glow 
glowing text… perhaps 

 

a ghastly silhouette (knockout glow) 

 
 

Bevel 
It adds a bevel to objects. It actually adds 2 colors to your object, Highlight & Shadow, which makes the objects appear 
to rise slightly. 

Blur x & y determines the blurriness of the bevel inside the graphic. 

Strength determines their opacity. 

Changing the angle will alter the bevel’s direction. To change it, click on the icon, then drag the ‘circle’ around. 

You can choose Highlight color and Shadow color too (refer to image below). Preferably, you should use a light color 
for highlight, and use a darker color for Shadow. 
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You can also select Knockout for bevel, which preserves the color of  the bevel, but makes the graphic invisible. 

What else you can create using bevel 
a crater effect, created using a knockout bevel 

 
  

 
Adjust Color 
Basically, this filter can be used to alter an objects color. The 4 properties of color which can be tweaked is 
namely, brightness, contrast, saturation and hue. 

They can be set from a value of -100 to 100 

Brightness defines the graphic’s brightness. 

A high contrast emphasizes the difference between different colors in a graphic. While an extremely low contrast can 
make the graphic completely grey. 

A high saturation accentuates the dominant colors in a graphic. Whereas a contrast value of -100 would make the 
color’s of the graphic completely gray scaled, which means it only comprises of white, grey and black colors. 

Hue alters the colors in the graphic. 

What else you can create using adjust color 
You can turn all color of movieclips in your movie grey, invoking a ‘old memory’ feeling to the whole scene. ( basically 
created by changing saturation to -100) 
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How to animate sprite in Flash 8 
 
how to import, cut, position, and animate sprites in Macromedia Flash 8. You will learn how to make the sprite animation 
below. 

Here is the summary of steps: 
1) Download sprite sheet 
2) Import sprite sheet to Flash 
3) Remove sprite sheet background 
4) Add frames and remove excess sprites 
5) Position sprites correctly 
6) Convert sprite to movieclip 

What are Sprites? 
Sprites are basically small bitmaps or image files that are made up of pixels. Mario, for example, is a sprite. 

1- Download sprite sheet 
You can download sprites at sites such as sprite-resource.com and reiner’s tileset.com. Choose, download a sprite 
sheet, extract it, then we can begin animating. 

2- Import sprite sheet to Flash 
Open Flash 8, then drag the image file from it’s directory, straight onto the stage of Flash 8. 

An alternative way is to select File>Import>Import to Stage. Choose the sprite image file in the dialog box, then click 
‘open’. The sprite sheet is imported to the stage. 

 
3- Remove background of sprites 
This process will transform the sprites into vectors. By transforming the sprite into vectors, you can easily eliminate the 
opaque background of the sprite. 

To do so, select the sprite in the first frame. Then, in the top selection pane, select Modify>Bitmap>Trace Bitmap. 

Make sure the settings are as the image below, then click OK. 
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Then, click on the background of the sprite. it is now a separate area from the character! 

 

Remove the background by press Ctrl+X or Delete. 

 

Remove excess background bits within the sprites. 

4- Add frames and remove excess sprites 
Firstly, add keyframes to the timeline by pressing F6, until the number of frames is the same as the number of 
actions/sprites. In this case, 12 frames. 

Now we have to ensure that each frame only contains one sprite/action of the character. We do so by removing the 
excess sprites in each frames. 

 

In the first frame, select all the sprites except for the first action/sprite. 
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Remove them by pressing the delete key. 

 

In the 2nd frame, select all sprites/actions except the 2nd sprite. 

 

Then remove them. Do the same for the next few frames. 

5- Position sprites correctly 
In this step, use the Onion Skin view to place your sprites on the same position correctly. 

First, click on the Onion Skin icon (refer to image below). This feature enables you to view objects in different frames. 
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Then, select the 2nd frame, and drag the sprite so that it is moved to the same position with the first sprite/action. Do so 
for all frames. 

 

One tip to ensure proper alignment, is to make sure the character’s left, or right foot’s position is the same. 
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6- Convert sprites to movieclip 
This step involves creating a movieclip object to hold the frames. This makes it easier to position the character 

anywhere on the stage. 

 

Firstly, select all frames in the timeline, then right click and select ‘Cut Frames’. 

 

Then, draw a dot or circle (any object will do) using the Brush Tool. Convert it to a movieclip by pressing F8, then click 
‘OK’ in the dialog box that pop-upped. 

 
Adding motion tween+motion guide to sprites in Flash 

 
covers using motion tween and motion guide to animate sprites in Flash. You are going to be shown how to make the 
animation below. 

  

  

First off, create a movieclip that contains an animation of a running sprite.. 

Motion tween to sprites 
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Now we’ll create a motion tween. Right click on the first frame, and select ‘Create Motion Tween’. Then, move the 
movieclip to the left edge of the stage. 

 

Click on the 20th frame, then press F6 to insert a keyframe. Flash automatically generates the frames between the first 
frame and the last frame. In the 20th frame, move the movieclip towards the right edge of the stage. 

 

Now the motion tween should be complete. Press Ctrl+Enter to test your movie. 

Motion guide to sprites 
No need to create a new Flash document, we’ll just continue from what we’ve done just now. 

Create a motion guide layer by clicking on the ‘Add motion guide’ icon. 
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Then, in that layer, draw a curvy stroke using the Pencil tool. And as always, it’s width, shape or color does not matter, it 
only has to be one continuous stroke. 

 

In the first frame, drag the character towards the start of the stroke, and in the last frame, move it to the end of the 
stroke. Note that your character is fixed on the stroke’s path. 

 

Ok, now it’s done. It should be something like the animation below. Press Ctrl+Enter to test your movie. 

Moving sprites using AS2 in Flash 
 
how to use simple actionscripts to move your sprites using the left and right arrow keys.  

  
Use arrow keys to move. 

 Here are the summary of steps 

1) Create ‘stop’ action movieclip 

2) Create ‘running’ movieclip 

3) Combine movieclips 

4) Insert actionscripts 

1- Create ‘stop’ movieclip 
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Create this movieclip which contains the character’s chillin’ out/standing animation. (The steps to do this is to cut out the 
sprites, place them in frames, and paste the frames into the movieclip). 

2- Create ‘running’ movieclip 
Then, create another movieclip, this one containing the character’s running animation. 

3- Combine movieclips 
Now, we are going to ‘combine’ both movieclips into one movieclip. First, convert the ‘stop’ movieclip into a movieclip 
object again. Do it by clicking on the movieclip, then press F8, and click ‘OK’. 

 
Then, cut the ‘running’ movieclip by clicking on it, then pressing Ctrl+X (cut). Double click into the movieclip containing 
the ‘stop’ movieclip, then press F7 to insert a blank keyframe into it’s timeline. 

 

On the movieclip’s stage, right clicking and select ‘Paste’ to paste the ‘running’ movieclip into the 2nd frame. Use Onion 
Skin view to ensure the ‘running’ movieclip and ‘stop’ movieclip is at the same position. If not, move the ‘running’ 
movieclip to the proper position. 

4- Insert actionscripts 
Now, select the first frame. Then, in the actions panel below, type in 

stop(); 
  

 
This script stops the movieclip’s animation on that frame. 

Then, double click somewhere on the stage to ‘get out’ of the movieclip. Select the movieclip, and insert the following 
script: 

onClipEvent (load) { 
 var speed = 10; 
} 
onClipEvent (enterFrame) { 
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 if (Key.isDown(Key.LEFT)) { 
 gotoAndStop(2); 
 _xscale=-100 
 _x -= speed; 
 } 
 if (Key.isDown(Key.RIGHT)) { 
 gotoAndStop(2); 
 _xscale=100 
 _x += speed; 
 
 } 
} 
onClipEvent (keyUp) { 
 gotoAndStop(1); 
} 

 
Here are some explanations for the script: 
var speed 
Defines your character’s speed 

if (Key.isDown (Key.LEFT)){ 
This detect’s if the left key is pressed. If the left key is pressed, 

gotoAndStop(2); 
The commands stops the movieclip at frame 2, which contains the running animation. 

_xscale=-100 / _xscale=100 
This command ‘flips’ the movieclip horizontally. _xscale =-100 means it is completely flipped over, while _xscale=100 
turns the movieclip to it’s original state. 

_x-=speed 
The movieclip moves left, as the smaller the x value, the closer to the left it is, and vice versa. 
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Double click the movieclip to enter it’s timeline. Right click on the first frame, and select ‘Paste Frames’ to transfer the 
frames into the movieclip. 

 

Now you’re done! Press Ctrl+Enter to view your movie. 

 
The Simplest Scripted Presentation Slider You Can Make With Flash 

 
step 1 – Create a new movieclip 
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Draw a dot using the Paint Bucket Tool, select it using the Selection Tool (the black cursor), then press F8. Make sure 
it’s “Type” is selected as “movieclip”. Then, press that ‘OK’ button to convert it into a movieclip symbol. 

step 2 – Add actionscript to movieclip 
Add the following actionscript to the movieclip. Don’t panic, most of the script below are only comments. 

onClipEvent (load) { 
this.stop();     //stops movieclip at the first frame 
this._alpha = 0; // set transparency to 0 
var a = false;   //a simple variable named "a", set as false 
} 
onClipEvent (mouseDown) { 
a = true; //if you clicked, variable "a" becomes true 
} 
onClipEvent (enterFrame) { 
//if transparency is lower than 100 percent, and "a" is false, then 
//transparency increases by 6 per second 
if (_alpha<100 and a != true) { 
_alpha += 6; 
} 
//if "a" is true, transparency decreases 
if (a == true) { 
_alpha -= 6; 
} 
//if transparency is smaller than 5, "a" becomes false, and 
//jumps to the next frame 
if (_alpha<5) { 
a = false; 
nextFrame(); 
} 
} 
It’s simple and self explanatory, read the comments (marked by //) within the actionscript for a better understanding of the script. 

step 3 – Add graphic elements into the movieclip’s frame 
Double click the movieclip to access it’s timeline, which contains it’s own set of frames. Then, erase the dot you drawn 
using the Eraser tool. 

Now you can insert graphic elements like textboxes and images into it’s frames. Also, simply press F7 if you want to 
create new frames. 

3.1 Importing graphics 
First you have to make sure you are within the movieclip’s timeline. Then,  simply drag images from their folder onto 
your Flash 8′s stage. 

3.2 Creating text boxes 
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Select the text box tool here. (indicated by red square) Then, drag your cursor on the stage to create a text box. 

 

You can change it’s size, color and style at the properties panel below, after it is selected. 

One important thing you have to know is that you have to use font’s other than sans, serif and typewriter, as their 
transparency cannot be altered. 

I found that other fonts like Arial would work fine. If you absolutely have to use the fonts mentioned above, there is 
an alternative, which is to break down the text box into vector graphics. 

You can do so by selecting the text box, then press Ctrl+B twice. Now they can be affected by transparency changes. 
The downside to this method is that you cannot edit or change the text or content afterwards as they’ve become 
graphics. 

step 4 – Making your Flash presentation full screen 
If you want to have a full screen Flash presentation, you must first change the stage of your Flash document to match 
your screens dimension. For my computer, I use 1366×768. 

 

First, right click on the stage, then select “document properties” to popup the dialog box above. There you can set the 
size and color of your Flash movie. 
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Then, insert this actionscript into the first frame of your main timeline. It set’s your Flash presentation to full screen 
automatically. 

fscommand("FULLSCREEN", true) 
 

Timeline commands 
 
Timeline commands such as stop() , play(), nextFrame(), prevFrame, gotoAndStop() and gotoAndPlay() are basic 
actionscript commands. Their use is to control the timeline. 

For instance, if I want to stop my Flash movie on the first frame, I simply apply a “stop()” command to it. 

These actionscript commands seem fundamental, but they can be used to accomplish complex tasks. For instance, you 
can create a point-and-click game using these simple commands. 

Below, I’ll explain the function of each commands. 

stop() : stops the timeline the frame it is applied to. 

play() : plays a frame that has been stopped. 

nextFrame() : Jumps to the next frame. 

prevFrame(): Jumps to the previous frame. 

gotoAndStop() : jumps toward a frame you specify, and stops on that frame. For instance, I use gotoAndStop(2) to 
jump to and stop at the second frame. 

gotoAndPlay(): Jumps to a frame you specify, and plays from that frame. For example, I use gotoAndPlay (3) to jump 
towards, and play at the third frame. 

nextScene() : jumps to the next scene 

prevScene() : jumps to the previous scene 

How to apply timeline commands to the timeline 
These commands are applied to frames in the timeline. 

Step 1: click on the frame you want to apply a command to. 

Step 2: click on the actions panel to expand it (if you can’t see the actions panel, in the top selection pane, select 
“Windows” > “Workspace layout” > “Default” to return the Flash document’s layout to it’s default state). 

Step 3: Type in a timeline command into the actions panel. For instance, “stop();” 
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(Image above) The Actions panel is where actionscripts are typed in. 

  

 

An alphabet “a” will show on a frame that has actionscript. 

 
Introduction to variables and data types in actionscript 2.0 

 

you learned how to control the timeline with simple actiosncript commands. Now you’ll learn what variables are. 

Basically, variables are data containers. Their main function is to store data to be retrieved later. 

It is denoted by a variable name followed by a piece of data. For instance, 

speed = 10; 
 
These variables can be a constant (unchanging). They can also be frequently changed. For instance, a variable that 
stores the score of a football video game would increase every time the player scores a goal. 
A variable’s data can be retrieved as many times as you want. For instance, in a game, you store your player’s name in 
a variable. When you’re talking to an NPC (non player character), he mentions your name by recalling the data inside 
the variable. 

 
Strict data typing 
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Strict data typing was introduced in Flash MX 2004. It requires a user to clearly define the data type of a variable. Some 
common data types a variable can store are strings, numbers, boolean, arrays and objects. In addition, the variable 
starts with a var. Below are some sample variables in accordance to strict data typing. 

var score:Number =10; 
var playerName:String= “hero”; 
var dead:Boolean =true; 
However, it is completely optional to use strict data typing. Flash forgives you even if you don’t want to use this style of 
programming. 

Yet, using the “proper” syntaxes develops a good habit that aids you when learning other programming languages like 
Java. 

Still, personally, I like to define a variable like this: 

var identifier = data; 
It is also acceptable to use 

identifier = data; 
However, for optimization purposes, placing a “var” in front of a variable is a better practice. Studies show that it could 
slightly speed up actionscript execution. 

 
Primitive data types 
To clarify, in Flash, there are 3 types of primitive data a variable can store: string, number and boolean. 

String 
Strings are text. For instance, 

var nickname = “simon”; 
 
“Simon” is the string contained by the “nickname” variable. Note that a string’s data must be enclosed by “ ” to be 
recognized by Flash. Even if you type in numbers to a string variable, it is considered as text, not numbers. 
Number 
A number variable can be used to perform mathematical operations. For instance, I can compute the sum of the 2 
variables below. 

var attack = 1; 
var damage = 2; 
trace (attack+damage); 
The result displayed would be 3. 

Boolean 
A Boolean variable only stores 2 types of data’s, true and false. For instance, 

var unlocked = false; 
This type of variable is useful for triggering events. For example, take a look at the script below. 

If (unlocked == true) { 
trace(“door opens”); 
}Else if (unlocked == false){ 
trace(“door is locked”); 
} 


